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Line Tile Painting @ 25% (Layer 1, RGB/8#) *
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Halfway down the (o8 0t e
tool bar there is
the gradient tool.

Click and hold on

EEee—— it and this box

el appears. Use the
paintbucket.

Click on the white
background
(unlock it by
double clicking on
the lock)
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Layers
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o Layer 0

Draw a line.
Make sure it
touches 2 sides.

At the top you'll
see a spot to
change the size
of the brush and
the hardness.

You can also
choose different
texture brushes.

Each line has its
own layer!!
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Select the layer
that the line is
on.
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Drop Shadow...
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Conkour Depth: New Style...
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Stroke

bevel. Change . N R ==
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Shadow Mode:

Opacity: a
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Line Tile Painting.psd @ 25% (Layer 1, RGB/8#) * ~

3

Drop Shadow: Adds a
shadow to the line.

Make the blend mode
normal, the opacity
makes it lighter or
darker. You can
change the distance,
size etc.
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Structure
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Cancel
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Preview
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7 Paths
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Line Tile Painting.psd @ 25% (RGB/8#) *

New Layer... Shift+Ctrl+N

Q Kind v®E e TR

When done, 4 - ) Horonal MRS AR  Dupiicate Layers..
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merge the layers. ] @
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Quick Export as PNG  Shift+Ctrl+*
O Effects Export As... Alt+Shift+Ctrl+*
O Bevel & Emboss

Click the top layer. . y N - [l el
Hold down the : 4 o B

shift button on the P , , o7 o Lo
keyboard. Click g ~ o

O FEffects

Convert to Smart Object

© Drop Shadaw
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Animation Options
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Close

Merge layers e : «
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Line Tile Painting.psd @ 25% (Layer 5 copy, RGB/8#) * ~
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iMake a copy of the

layer just in case. (click
and drag it down to the
new layer button at the
bottom of the layers
panel.
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Undo Move Ctrl+Z
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Toggle Last State Alt+CtrleZ

ansform Controls =

Paste Ctrlev — - b o

Paste Special » Q Kind - ® @ T HO R

Normal v | Opacity: | 100% | v
Search

Check Spelling... lock: Bl 4 & DY @ Ak 100% v
Find and Replace Text... {
Fill.. Shift=F5

Stroke.
ter Fill...

Content-Aware Scale  Alt+Shift=Ctrl+C
Puppet Warp

Perspective Warp
Free Transform Ctrl+T 7’ 3
Again shiteCtrleT g ¥ 4 v
> ‘ Scale ’ l

Rotate

Skew

Distort
Define Custom S Perspective

Purge

Adobe PDF Preset:

SV Make a copy of the

Remote Connections...

ol B ShifteCtrbeK | e : Sma”er tlle Then

Tt Rotate 90° Clockwise

S Rotate 90° Counter Clockwise CI ick Ed it>

Keyboard Shortcuts...  Alt+Shift+Ctrl+K
Menus... Alt+Shift+Ctrl+M

Transform> Flip

Horizontal. Move it
to the top right
corner.
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Undo Move Ctrl+Z
Redo Flip Vertical Shift+Ctrl+Z
Toggle Last State AltCtrl+Z

Paste Ctrl+V
Paste Special ’

Search
Check Spelling...
Find and Replace Text...

Fill... Shift+F5
Stroke.
re Fill...

Content-Aware Scale  Alt+Shift=Ctrl+C
Puppet Warp

Perspective Warp

Free Transform Ctrl+T

Transform k

Define Brush Prest
Define Patter:

Define C
Purge

Adobe PDF Preset:
Presets
Remote Connections...

Color Settings... Shifts Ctrl+K
Assign Profile...
Convert to Profile...

Keyboard Shortcuts...  Alt+Shift+Ctrl+K
Menus... Alt+Shift+Ctrl+M
Toolbar...

Preferences
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Layers
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Make a copy of
that tile.

Edit > Transform?
Flip Vertical.
Move it to the
bottom right.
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Undo Move Ctrl+Z

H : e
Ct

TR Toggle Last State Alt+Ctrl+Z

-ansform Controls

Shift+Ctrl+F

Ctrlev P Layes
5 Q Kind vEeTHOMR
Normal « | Opacity: 100%

Check Spelling... lock: Bl 4 & DY @ Ak 100% v
Find and Replace Text... P 4 : -

Layer 5copy 4
Fill... Shift+F5

- Loz
Stroke. . y . ceomys
e , = P
d 5

Content-Aware Scale  Alt+Shift=Ctrl+C . ‘ - \ ﬁ Layer 5 copy 2
Puppet Warp | .

Perspective Warp | 2 sy
Free Transform Ctrl+T

Scale

Rotate
Define Brush Pres Skew
Define Pattern... Distort
Define Custom Sha Perspective

Make a copy o
Adobe PDF Preset l ﬁ ; ‘: 1 g . : : that tlle Ed|t>

Presets

g e ‘ ' 7 o Transform> Flip

Purge

Color Settings... Shift+ Ctrl+K T

Sevan broile.. Rotate 90° Clockwise : » H orizon ta I
SR Rotate 90° Counter Clockwise f 1

Keyboard Shortcuts... ~Alt+Shifts Ctrl+K

Menus... Alt+Shifts Ctrls M

sl Ve 4 =7 /9 Move it to the
bottom left
corner.
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A v  rmw v & Cear  figj Straighten @ L [ Delte Croppad Pixels Content-Aware

Line Tile Painting.psd @ 25% (Layer 5 copy 2, RGB/8#) *

Layers

=

Q Kind v®E e TR
Normal v | Opacity: | 100% | v

lock: B /¢ DY @ Al 100% v

Use the arrow
keys on the
keyboard to move

LR the tiles until they
all line up.
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“ -L—I_ Mode

3

Clear Straighten

2 TS Adjustments Brightness/Contrast...
Line Tile Painti

Auto Tone Shift+Ctrl+L
Auto Contrast  Alt+Shift+Ctrl+L
Auto Color Shift+Ctrl+B

Image Size... Alt+Ctrl+]
Canvas Size.. Alt+Ctrl+C

Image Rotation

Trim...
Reveal All

Duplicate...
Apply Image.
Calculations.

Variables
y D

Traj

Analysis
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Levels... Ctrl+L
Ctrl+M

Vibrance.
Color Balance. Ctrl+B
Black & White... Alt+ShiftCtrl+B
Photo Filter.
Channel Mixer
Color Lookup..

Invert Ctrl+|
Posterize...

Threshold...

Gradient Map.

Selective Colol

Shadows/Highligh
HDR Toning...

Desaturate
Match Colol
Replace Color.
Equalize

»

#

3 (3 Delete Cropped Pixels

Content-Aware

Layers

Qknd v @ @ T O @
Normal v Opacty: 100% v

lock: B8 2 b Iy @ Al 100% v

Select the top
right panel.

Image >

=% Adjustments >

v
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& X v samplsSem PointSample v

Line Tile Painting.psd @ 25% (Layer 5 copy 2, RGB/8#) * *

Hue/Saturation

Preset: ~ Custom

Master

Lightness: iy ‘ 4 Change the Hue to
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A P DaoSeect | Layer o Show Transform Controls [ ]

Line Tile Painting.psd @ 25% (RGB/8#) *

New Layer. Shift+Ctrl+N

Qwd + B @ T O R
3 g el v | Opacty:| 100% Duplicate Layers...
. 4 ; \ (PP I A SRS M|  Dcctc Lovers
O the same Delte Hidden Layers
y . © 1 iR Quick Export as PNG  Shift Ctrl+"
tO the bOttO n - o ﬁ \ P—. Export As.. Alt+Shift+ Ctrl+"
e o E Layer 5copy 3

New Group..

. -
Ieft tlle. ‘ % ~ > L toyers tngr2 New Group from Layers...

Collapse All Groups

O g Layer 5 copy New Artboar

= Arth om Grou

Merge the 1 ) : \ s s Artboard from Laye

Frame from Layers...

layers when i - ~ oo

Lock Layers... Ctrl+/

done. :

Edit Co s

Create Clipping Mask  Alt=Ctrl+G

Link Layers
S Lin|

Merge Layers Ctri+E

Merge Visible Shift+Ctrl+E
Flatten Image

Animation Options
Panel Options...

Close
Close Tab Group
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La: r

A P - ODaoSdect  Layer o

Convert for Smart Filters
Line Tile Painting.psd @ 25% (Layer 5 copy 4, Rf

Filter Gallery..

Adaptive Wide Angle... Alts ShiftsCtrl+A

Camera Raw Filter... Shift+ Ctrl+ A

Lens Correction... Shift+Ctrl+R

Liquify... Shift Ctrl+X

Vanishing Point... Alt+CtrlsV : s 3 ] Layes

3D = E Qknd v @ @ T O B
Blur

Blur Gallery h 4

Distort e 2 : lock: B ¢ b Iy B Al 100% -
Noise ,

Normal v | Opacity: | 100% | v

Pixelate
Render
Sharpen
Stylize
Video
Other

Add a filter to
finish it up!

Filter > Filter
Gallery
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Filter Gallery (100%)

> I Artistic

» I Brush Strokes
» I Distort

» B Sketch

» I styize

> B Texture

It'll pop up super
zoomed in.

Click on the
small minus
button at the
bottom left.
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Plastic Wrap (25%)

L Type here to search

¥ = Artistic

Sponge

» I Brush Strokes
» I Distort

» I Sketch

> I styiize

> I Texture

All the folders have a
ton of options. Try a
bunch!

Pick one you like.

8

Cancel

Plastic Wrap

Highlight Strength
Detail

Smoothness
-

© Plastic Wrap

A 1)
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Sponge (25%)

¥ = Artistic

Sponge

» I Brush Strokes
» I Distort
» I Sketch
> I styiize
» i Texture

Here’s another
filter....keep
seeing which you
like best.

2

Cancel

Sponge

Brush Size
a

Definition

Smoothness
a

A 1)
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New... cri-N
Open... Ctrl+0
Browse in Bridge... AlteCtri+0  PYES
Open As... Alt+ Shift+ Ctrl+ O
Open as Smart Object..
Open Recent »

Close Ctrl+W
Close All Alt+Ctrl+W e
s Alt+Ctrl+P

Close and Go to Bridge... ~ Shift+Ctrl+W > p - ~ Q Kind vE @ THOR
Normal v Opacty: 100% v

lock: Bl 4 & DY @ Ak 100% v

Generate
Share...
Share on Behance...

Search Adobe Stock...
Place Embedded...
Place Linked..
Package.

Automate
Scripts
Import

File Info... Alt+Shift+ Ctrl+1

3 S When you are done
Print One Copy Alt+Shift+ Ctrl+P ' : 3 < " » ) . ¢ d and you Want to

Print... Ctrl+P

Exit Ctrl+Q

hand itin....

File > Save As
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@ savess
= > ThisPC > CDopico (\\fileserverh\users$\HighSchool) (H:)

Organize v+ New folder

B Color Q Learn

Name modified
o Quick access

[ Desktop
& Downloads

Swatches
2019 Artwork 0 f e
adding patter to landscape 0 y g
Archive Ber Fatiams

=/ Documents Scholastic Submissions 2019

- Q Kind @ eTHOMR
& Pictures ¢ screenshots i
== CDopico (\\fileserve @ abstractcollageextraprojectexample
D Music @ bill nye
B Videos B cat collage
@ cetCollage2020
@, OneDrive @ chimera 2019
e B collage portrait
@ denim dress
¥ Network @ drake

C Normal v Opacity:  100% v
Photosh: »

lock: Bl b DY @ Al 100%

Photoshop (*.PSD;*.PDD;* PSDT)
Large Document Format (*.PSB)
BMP (.BMP;*RLE:*.DIB)

Dicom (*.DCM;*.DC3;%.DIC)
Photoshop EPS (*EPS)
Photoshop DCS 1.0 (*.EPS)
Photoshop DCS 2.0 (*.EPS)

~ Hide Folders

JPEG Stereo (*JPS)

Multi-Picture Format (*.MPO)

PCX (*PCX)

Photoshop PDF (*.P

Photoshop Raw (*.

Pixar (*.PXR)

PNG (*PNG;*PNG)

Portable Bit Map (*.PBM;*.PGM;*.PPM;*PNM;*PFM;*.PAM)
Scitex CT (*.5C

TIFF (. TIF:".TIFF)
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@ savess
« v A~ E> ThisPC >

Organize v

d’
s Quick access

[ Desktop m Videos
& Downloads
=] Documents ~ Devices and drives (1)
&= Pictures Windows (C:)
ico (\filese |
= CDopico (\\fileserve -
D Music
v Network locations
B Videos
CDopico
(\\fileserverh\users$\HighSchool)...
I

@ OneDrive

[ This PC Teacher (U:)

™
e ————————
& Network - 8

File nami Tile Painting
Save astype: | JPEG (*.JPG;"JPEG;" JPE)

Save to cloud documents

Other: Thumbnail

~ Hide Folders

3260 px x 3276 px (300 ppi)

L Type here to search

Layers

Q Kind HeTHORMR
Normal v | Opaciy: | 100% | v

lock: B8 4 b Iy @ Al 100% v

This PC > scroll
down and find
your drive with
your name on it.

Open, Save

Gradients

Patterns.

A 1)
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& W O scrol Al Windows 100% Fit Screen il Screen

Line Tile Painting.psd @ 25% (Layer 5 copy 4, RGB/8#) *

JPEG Options X

Matte: | None v
Image Options

Cancel
Quality: 8 High v

small file large fle Preview
&

Format Options
© Baseline ("Standard™)

C I iCk o k ) . Baseline Optimized
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Progressive
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Go hand it in under the
assignment on google
classroom!!

Instructions on handing in work
etc is always on our daily slide
but also on the stream for our
class on google classroom.



